Mac Formatting Guide

Covers Disk Utility For:

10.13 and later

Introduction

This guide focuses on the Disk
Utility application, specifically

the changes made starting with
macOS 10.13, and the process
of formatting your Apple or

OWC storage device. If you're
accustomed to earlier versions of
the Disk Utility, please read this
document to get familiar with the
above-noted changes.

Interface Changes:

The user interface (right) is largely
the same when compared to the
Disk Utility in 10.12, but there
are key differences that will be
discussed in this document.

The most important of these is
the transition to a new start disk
format called ‘APFS’ — short
for APple File System) and the Ul

conventions related to that format.
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Mount Point: / | Type:
Capacity: 499.96 GB Owners:
Available: 333.23 GB (3.57 GB purgeable) Connection:

Used: 167.47 GB | Device:

Info

499.96 GB

SHARED BY 4 VOLUMES

Free
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APFS Volume
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PCI-Express
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Another difference you may notice right away is that there is a new View menu in the top-left corner of the window.
This item can be useful if you have connected a disk and it doesn’t appear right away in the sidebar area —in that case
choose the ‘Show All Devices’ option. Let’s take a look at the formatting process.
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Step 1:

Typically the easiest way to access
the Disk Ultility application is to use
the Spotlight search tool built into
your OS X Menubar.

Click the magnifying glass icon in
the top-right corner of your screen.
Type ‘Disk Utility’. The first search
result should automatically highlight
the application. Press the Return
key to open the utility.

Step 2:

Examine the device tree (i.e. the
Sidebar). Previous versions of the
Disk Utility allowed interaction
with your drive at two levels in the
device tree. The physical device
was referred to as the ‘Disk’ or
‘Physical Disk,” and any logical
storage spaces on that disk

were referred to as ‘Volumes’ or
‘Physical Volumes.’ Disk Utility in
10.13 changes the default behavior.

For volumes using the new APFS
format, there are now three levels
of interaction: ‘Physical Disks,’
‘Container Disks,” and ‘APFS
Volumes,’ as shown above-right.

For volumes not formatted with
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® FLASH_MEDIA
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USB External Physical Disk « Master Boot Record

Location: External Capacity: 7.91 GB

Connection: USB | Child count: 1
Partition Map: Master Boot Record Type: Disk
S.M.ART. status: Not Supported Device: disk5

APFES, Disk Utility maintains backward compatibility with the original method, listing ‘Physical Disk’ for the device and
‘Physical Volume’ for the logical spaces defined on the device. Examples of both types are shown above-right. Under
the ‘External’ tree listing, the ‘SMI USB Disk’ (highlighted) shows the legacy behavior that many people are used to, while
the two devices above it show the new APFS behavior for internal and external devices. Notice how the three levels are
grouped; the importance of this will become obvious as we move through the remaining steps.
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Step 3:
For our example we disconnected ®0e0
the previously shown devices and i
View Volume

replaced them with what you will
typically see with a pre-built OWC
storage solution that is connected
“out of the box.”

Internal
v [Z] APPLE SSD SM...
v [} Container disk1
[Z) Macintosh...

External

v [] OWCOWC Mer... 4

Beneath the ‘External’ portion of
the device tree, notice that the
highlighted device does not have a
‘Container’ level —this is because
OWC does not ship drives in APFS
format. Instead it is shipped in a
format that will work out of the box
on either a Mac or PC.

The steps that follow will show

options for creating a new APFS

volume —typically the best choice

for SSDs (and the macOS 10.13 default).

Step 4:
a) Click the ‘Erase’ button at X
the top of the window. This
View Volume

will open a macOS ‘sheet’
(highlighted) that will provide the
formatting options.
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Open the ‘Scheme’ menu and
switch the setting from ‘Master
Boot Record’ to ‘GUID Partition
Map;’ APFS settings will be
added to the ‘Format’ menu.

It is not possible to use APFS
with other scheme types.

External
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»

Give your drive a name.

Finally, within the ‘Format’
menu choose ‘APFS’. Note
there are three other APFS
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Info

240.06 GB

® OWC SETUP
240.06 GB

Location: External

Connection: uss
Partition Map: Master Boot Record

S.M.A.R.T. status: Verified

Disk Utility

First Aid Partition Erase Restore

SSD Media"?

Erase to proceed.

Name: ' Media Files|
Format: APFS

Scheme: GUID Partition Map

Security Options...

Mount

Erase “OWC OWC Mercury Electra 6G

Erasing "OWC OWC Mercury Electra 6G SSD Media" will
delete all data stored on it, and cannot be undone. Provide
a name, choose a partition map and format, and click

Cancel

Capacity: 240.06 GB
Child count: 1
Type: Disk

Device: disk2

Info

= 240.06 GB

Connection:
Partition Map:

S.M.AR.T. status:

UsB

Master Boot Record

Verified

| ¥
| v ]
Erase
) 240.06 GB
Child count: 1

Type: Disk

Device: disk2

formatting options, but unless you or your system administrator have a specific reason for choosing one of them,
‘APFS’ is recommended for most uses. If you prefer HFS+ — also called Mac OS Extended (Journaled) and often a
better option if you’re using mechanical hard drives — you can choose that option from the ‘Format’ menu instead. If
you’re interested in understanding why APFES is better-suited to SSDs, please see this blog post.

Note the location of the ‘Erase’ button on the sheet.


https://blog.macsales.com/43043-using-apfs-on-hdds-and-why-you-might-not-want-to
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Step 5:

Click the ‘Erase’ button mentioned @®e® Disk Utility

in Step 4e. ®
View Volume First Aid Partition Erase Restore Mount Info

This will begin the formatting el

O RIS S ‘== ' Erasing “OWC OWC Mercury Electra 6G SSD Media” and

process and open a new sheet i o h creating “Media Files”
(shown at right) that provides the o Comenerdid Creating APFS Volume
option for displaying the details of & Macintosh..
said process. Once the process

is complete the ‘Done’ button will G
become active. Click it to continue. Creating:a new empty/ARFS Contalher

Unmounting Volumes

Switching disk2s2 to APFS

Creating APFS Container

Created new APFS Container disk3

Preparing to add APFS Volume to APFS Container disk3

External ¥ Hide Details
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Creating APFS Volume 240.06 GB
2
\_ ) Disk
S.M.A.R.T. status: Verified Device: disk2
Afterward, you may have to click eoo Disk Utility
the expander widget to the left of o~ ¥ ol 2 9 ®
the phySicaI dlSk IiSting, in order to View Volume First Aid Partition Erase Restore  Mount Info

see the newly created container e —
, v | —
and volume (right). & APPLE SSD SMOS1 . _ . OWC OWC Mercury Electra 6...
v [| Container disk1 . . . . 240.06 GB
= USB External Physical Disk « GUID Partition Map
[Z] Macintosh...

External
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® Media Files
| MediaFiles = 239.85 GB
Location: External Capacity: 240.06 GB
Connection: USB | Child count: 2
Partition Map: GUID Partition Map Type: Disk
S.M.A.R.T. status: Verified Device: disk2
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Containers vs. Partitions

Before we continue, recall that with previous versions of Disk Utility you could create multiple ‘Partitions’ within a single
physical disk, allowing some flexibility to how the total amount of disk space was used. While it is still possible to partition
a physical disk to create multiple APFS volumes, APFS uses the new method of multiple volumes sharing a single
container. The primary advantages of Apple’s new method are that it is less complex than the prior method and that the
newly added volumes use the disk space more dynamically, setting —in effect —minimum and maximum capacity values
for the volume. This allows unused space to be utilized by other volumes that might require it. We cover both processes.

Creating Additional Volumes (optional):

With previous versions of Disk Utility, you could create multiple ‘Partitions’ within a single physical disk, allowing some
flexibility to how the total amount of storage space was used. While it is still possible to partition a physical disk in order to
create multiple APFS volumes, APFS uses the new method of multiple volumes sharing a single container.

The primary advantages of o0 Disk Utility
Apple’s new method are that it M~ 9| ol 2| 5 s ®
|S |eSS Complex ‘than the pr|or View Volume First Aid Partition Erase Restore  Mount Info

method, and that the newly added Internal

volumes use the disk space more ]| GEHEECREN .. Container disk3 s
dynamically, setting —in effect —

APFS Container
minimum and maximum capacity

v [ Container disk1

= . ONE VOLUME
=] Macintosh...

values for the volume. This allows sl

- v [ owc owcC Mer.. ©
unused space to be utilized by

. . . ontainer ais... - " .
other volumes that might require it. r—— © Media Files Free
[| Media Files 4 49 KB 239.71 GB

Step 6v
To create a new volume within Volume count: 1| Type: APFS Container
the COﬂtalnel’ yOU Created Iﬂ Capacity: 239.85 GB Physical stores: disk2s2
the previous steps, highlight the Free: 239.71GB | Connection: uss
Contalner, then click the ‘Add Used: 136.8 MB | Device: disk3

Volume’ button at the top of the
window (highlighted above-right).
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Step 7v

Give the new volume a name,
select one of the four available
APFS format options — standard
APFS is recommended for more
uses —then click the ‘Size
Options...” button.

Note that only APFS volumes can
share the same Container, due

to the inability of older formats to
have their capacity dynamically
adjusted.

Step 8v

Use the ‘Reserve Size’ feature

to set a minimum capacity for

the new volume; this is the only
setting of the two available that is
required. Additionally you can set
a ‘Quota Size’ in order to ensure
the new volume does not occupy
more of the available capacity than
you want.

For the example shown, the
volume will not occupy less than
50GB or more than 100GB.

GB 50-100 can be dynamically
allocated by the system to allow
other volumes to use this space, if
necessary.

Click OK. When you’re done, then
click the ‘Add’ button shown in the
screenshot at the top of the page.
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Disk Utility

First Aid Partition Erase Restore  Mount

‘===m ' Add APFS volume to container?
——

L APFS volumes share storage space within their container.
= Provide a name and format, and click Add to proceed.

Name: | Other Filesl

Format: = APFS [T
Size Options... Cancel
Volume count: 1 Type:
Capacity: 239.85 GB Physical stores:
Free: 239.71GB | Connection:
Used: 136.8 MB | Device:
Disk Utility

First Aid Partition Erase Restore  Mount

Size Options

APFS volumes share storage space within their container.

The optional reserve size ensures that amount of storage
will remain available for this volume. The optional quota
size limits how much storage this volume can allocate.

Reserve Size: 50 GB [
Quota Size: 100 GB [
J
Volume count: 1 Type:
Capacity: 239.85 GB Physical stores:
Free: 239.71GB | Connection:
Used: 136.8 MB | Device:

Info

239185 GB

ONE VOLUME

APFS Container

disk2s2

usB

disk3

Info

239185 GB

ONE VOLUME

APFS Container

disk2s2

usB

disk3
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Adding Volumes - Wrap Up

Once you have completed the
previous steps, you should see
two (or more) volumes sharing a
single container on your disk. How
much capacity is available to each
of them will depend on how you
set them up and how much data
you place within each one. Note
the Reserve and Quota amounts in
the blue highlighted area.

To Remove a volume — warning:
this will erase all of that
volume’s data! — highlight it and
click the ‘Delete Volume’ button,
highlighted above in red. (You can
also right-click on a volume to
access this command, as well as
the ‘Add Volume’ command and
others.)
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Creating Additional Partitions (optional):

While it is a more complex process, the one advantage to creating a new partition, is the volume can have a fixed capacity
that is wholly dedicated to the new volume — none of the capacity can be dynamically re-allocated to other volumes.

Step 6p

To create a new partition and fixed
capacity volume, highlight the disk
and click the ‘Partition’ button.

The first time you do this a sheet
will appear with a notice explaining
the two options available, and
providing an option to ‘Always
Partition’ if you wish to work that
way. When you’re ready click the
‘Partition’ button on the sheet.
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Other Files

APFS Volume « APFS

Other Volumes

25 KB (50 GB reserve)

Mount Point: /Volumes/Other Files Type:
Capacity: 100 GB quota Owners:
Available: 100 GB (Zero KB purgeable) Connection:
Used: 25 KB (50 GB reserve) Device:

Disk Utility

First Aid Partition Erase Restore Mount

Apple File System Space Sharing

APFS volumes share storage space within a container,
occupying a single partition. Adding and deleting APFS
volumes is faster and simpler than editing a partition map.

To add a new volume to a container without seeing this
message, use the Add APFS Volume command in the Edit menu
or the Add/Delete Volume toolbar item.

Would you like to add a volume to the container, or partition
the device?

Always partition

Info

100 GB

SHARED BY 2 VOLUMES

(100 GB QUOTA)
Free
100 GB
APFS Volume
Disabled
USsB
disk3s2

Info

240.06 GB

Partition Cancel
Location: External Capacity: ) 240.06 GB
Connection: USB | Child count: 2
Partition Map: GUID Partition Map Type: Disk
S.M.A.R.T. status: Verified Device: disk2
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Step 7p

The disk partition sheet will appear,
including a blue pie chart. Click
the ‘+’ button beneath the pie
chart (highlighted) to create a new
partition.

Step 8p

A new partition will be created,
splitting the total capacity in half
(assuming there are only two

in total), with the new partition
selected.

Type a name for the new partition,
select APFS or Mac OS Extended
(Journaled), and then click the
‘Apply’ button. Here the new
volume within the new partition will
be called ‘Other Files.’

Note that if you create a new APFS
partition, a new Container will be
created as well.

®e® Disk Utility

<

View Volume First Aid Partition Erase Restore  Mount Info

Partition device “OWC OWC Mercury Electra 6G SSD Media”?

Click add (+) to increase the number of partitions on the device. Click on each partition to change the name and format. Drag
the resize control or enter the size of each partition and click Apply.

Device Information
Device: OWC OWC Mercury Electra 6G SSD Media
Scheme: GUID Partition Map
Size: 240.06 GB

Partition Information

Name:

Format: APFS
Media Files §

240 GB Size: [E 68 [

This container has 136.8 MB used space.
You can not remove the first volume on the disk.

? Cancel

®e® Disk Utility

View Volume First Aid Partition Erase Restore  Mount Info

Partition device “OWC OWC Mercury Electra 6G SSD Media”?

Click add (+) to increase the number of partitions on the device. Click on each partition to change the name and format. Drag
the resize control or enter the size of each partition and click Apply.

Device Information
Device: OWC OWC Mercury Electra 6G SSD Media
Scheme: GUID Partition Map

Size: 240.06 GB

Other Files Media Files

120 GB 120,68 Partition Information

Name: ‘Other Files ‘

Format: Mac OS Extended (Journaled) ﬁ

This partition will be created.

? ~ Revert Cancel ~ Apply

N\ J




Mac Formatting Guide (10.13 / APEFS)

Step 9p
A warning sheet will appear, Disk Utility
notifying you that a new partition @
|S belng added and the eX|St|ng View Volume First Aid Partition Erase Restore  Mount Info
one resized. Click ‘Partition’ to ‘| = Partition de Partition device "OWC OWC Mercury Electra
Contlnue Wlth the prOCGSS- h Click add (+) td CCISSDiMediats ge the name and format. Drag
the resize cont Partitioning this device will change some of the
partitions. No partitions will be erased.
This partition will be added:
E
N "Other Files"
This partition will be resized: Media
"Media Files"”
Other Files Cancel Partition
120 GB \ /
Name: Other Files
Format: Mac OS Extended (Journaled) o
Size: 120 GB ¢
This partition will be created.
+ | —
2 Revert Cancel Apply
Step 10p
Similar to the initial formatting of LA Disk Utility
the drive, a new sheet will appear o~ Ll Ecl =S B @
View Volume First Aid Partition Erase Restore = Mount Info

during the re-partitioning process.
When the process is complete,

, ‘ , v [Z] APPLE SSD SM.. —
click the ‘Done’ button. - o . . OWCOWCMercuryElectra6... | ,,0505
v & Container disk1 - USB External Physical Disk « GUID Partition Map

Internal

. , - Q Macintosh...
Now the main Disk Utility screen
. . . External

will display an updated capacity
graph, indicating it has been splt MR
into two partitions. Note in the B e I @ otner les
device tree we now show a mixed O otherfies 4
environment with both an APFS
aﬂd MaC OS EXTeﬂded (Jouma|ed) Location: External Capacity: 240.06 GB
volume on the same external disk. S— P — 4

. . Partition Map: GUID Partition Map Type: Disk
This completes the formatting » : :

S.M.ART. status: Verified Device: disk2

and partitioning instructions. If
you have questions about how to
properly set up your OWC storage
solution, please contact our
technical support team.
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https://www.owcdigital.com/support/contact

